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CQG Trader User Guide 

About this Document 
This document contains all the information you need to use CQG Trader.  

You can navigate the document in several ways: 
• Click a bookmark listed on the left of the page. 

• Click an item in the Table of Contents. 

• Click a blue, underlined link that takes you to another section of the document. To go 
back, use Adobe Reader Page Navigation items (View menu). 

If you are looking for a particular term, it may be easier for you to search the document for it. 
There are two ways to do that: 

• Right-click the page, and then click Find. 

• Press Ctrl+F on your keyboard. 

This document is intended to be printed double-sided, so it includes blank pages before new 
chapters. 

To ensure that you have the most recent copy of this guide, please go to the user guide page 
on CQG’s website. 

 

http://www.cqg.com/Support/User-Guide.aspx
http://www.cqg.com/Support/User-Guide.aspx
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What's New in this Release 

Trading in Units Versus Lots 

Application_Name has been updated to allow trading by units instead of lots.  

Trading in units is similar to trading in lots. The difference is that you can place large orders in 
lots as one order in units. 

For example: 

<unit commodity="F.EP" lotsInUnit="10"/> 

In this case, placing an order for 1 unit is the same as placing an order for ten lots. Notice the 
Qty and QtyU fields on the Working Orders window: 

 
To trade in units, you first need to enable units trading and upload an xml conversion file. See 
“Units” in Display Configuration preferences on page 51. 

For details about units trading, see “Trading Units Versus Lots” on page 69. 

Also introduced in the version: OTE & P/L can be displayed as a percentage of the account 
summary. 

Save this sample xml file to your machine as a way to get started creating your own conversion 
file. 

Preferences 

Added three additional notification options: 

 
 

Added a second option to fill mode: 

 
 

http://www.cqg.com/docs/SampleUnitsConfiguration.xml
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Added Key Action Help (shortcut keys) profiles:  

 
 

Related Documents 
CQG Tradable Symbols 

Symbology for Exchange-Traded Strategies 

CQG Order Type Matrix 

http://www.cqg.com/Docs/Symbols.pdf
http://www.cqg.com/Docs/ExchangeTradedStrategies.pdf
http://www.cqg.com/Docs/OrderTypeMatrix.pdf


Fore
xxin

/Cas
ey

Page 4 

About this Document 

Customer Support 
Please contact your FCM for account-related information, such as order status, position, and 
risk setup. 
 
For assistance using CQG Trader, please contact CQG customer support. Support can be 
reached by phone from Sunday, 2:30 p.m. CT through Friday, 5:00 p.m. CT. These hours also 
apply to Live Chat. 
 

United States 1-800-525-1085 

United Kingdom +44 (0) 20-7827-8270 

France +33 (0) 1-74-18-07-81 

Germany +49 (0) 69-6677-7558-0 

Japan +81 (0) 3-3286-6877 

Russia +7 495-795-2409 

Singapore +65 6494-4911 

Sydney +61 (2) 9235-2009 

 

E-mail websupt@cqg.com 24 hours a day, 7 days a week. 

If you have questions about CQG documentation, please contact the help author. 

 

 

mailto:websupt@cqg.com
mailto:michelle@cqg.com?subject=DeMark%20User%20Guide
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CQG Trader 
CQG Trader is a powerful tool for quickly viewing market activity, placing orders, and managing 
orders and positions. 

To become a productive CQG Trader user, it is recommended that you invest some time in 
learning and understanding how the tool works. This document provides the information you 
need. Please note that the images are examples only and may look different from your system. 

Please note that images are examples only and are meant to demonstrate and expose system 
behavior. They do not represent actual trading situations. 

Viewing Connection Status 
You can check the status of your system connections at any time. 

Click the CQG Trader icon on the status bar (bottom-right of your screen). 

Normal 

 
Issues 

 
 

The status closes when you move your mouse away from the message.  

You can set CQG Trader to display the dialog every time the connection status changes.  
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Changing Your Password 
Your password must be between one and thirty-two characters and may include letters, 
numbers, and spaces. Passwords are case-sensitive. 

1. Choose Setup > Change Password. The Password Change window is displayed. 

2. Enter your old password. 

3. Enter your new password. 

4. Enter the new password again. 

5. Click Change. If you click Cancel, your password is not changed.  

CQG Trader API 
The CQG Trader API allows you to connect to CQG Trader using a COM interface. Once 
connected, you have access to trade data, such as accounts, quotes, and orders and positions. 

You can use the API in two ways: 

• API only: Add CQG Trader functionality to your front end. In this case, you log on to 
CQG Trader programmatically and then use the API-defined interfaces and methods to 
collect and work with CQG Trader data.  

• CQG Trader + API: Incorporate your proprietary code using the CQG Trader front end to 
expand existing CQG Trader functionality. In this case, you log on to CQG Trader as 
usual, turn on access to the API, and start your program or script that uses the API. 

To turn on the API, right-click the Quote Board title bar, click API, then click Enable 
API. 

For more information, please go to the API website or view the samples and help files 
(CQGTrader_Com_API.zip) at: ftp://OpenAPI:k-rxERRdigxQ@ftp.cqg.com/CQGT%20API/.  

The API requires an enablement. 

http://www.cqg.com/Products/CQG-API/CQG-Trader-API.aspx
ftp://OpenAPI:k-rxERRdigxQ@ftp.cqg.com/CQGT API/


Fore
xxin

/Cas
ey

  Page 7 

CQG Trader User Guide 

CQG Trader Window Components 
The CQG Trader window is divided into three panes for: 

• Entering orders: Either the DOMTrader or the Order Ticket, depending on your 
settings, is displayed on the left side of the window. Both allow you to monitor current 
market activity and place orders quickly and easily. 

• Viewing quote data: The Quote Board, at the top-right of the window, allows you to 
monitor data, such as open, close, and last prices. 

• Managing orders and positions: Orders and Reports, on the bottom-right of the 
window, allows you to track order activity and positions for all the accounts that are 
available to the trader logged on.  

Located at the top of the CQG Trader window, the menu bar provides access to Setup, View, 
Orders, News, and Help functions. You can also right-click the Quote Board title bar to access 
these options. 

• The Setup menu has options for changing your password and setting order and position, 
display, order placement, and notification preferences. 

• The View menu has options for displaying the Orders & Reports pane, adding a 
DOMTrader or an Order Ticket to your display, and opening the Messages window. 

• The Orders menu is used to access batch order entry. 

• The News menu provides access to the News window and preferences. 

• The Help menu has options for opening the About window, online help, a tradable 
symbols list, a key actions list (keyboard shortcuts), and the CQG Trader API webpage. 

All of these components are described in this document. 



Fore
xxin

/Cas
ey



Fore
xxin

/Cas
ey

  Page 9 

CQG Trader User Guide 

Order Ticket 
The Order Ticket is an order entry application that combines an order ticket with elements of 
the DOMTrader. 

The DOM area contains buy, volume, price, and sell columns. 

Place orders using the buy and sell buttons. 

In Order Placement preferences, you choose whether to display the Order Ticket or the 
DOMTrader. 

Adding an Order Ticket 
Up to three Order Tickets can be added to the CQG Trader window.  

To add an Order Ticket: 

1. Click View. 

2. Click Add OrderTicket view. 
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Order Ticket 

Order Ticket Components 

Title bar  

The DOMTrader title bar displays the symbol and account number.  

 
Learn how to change accounts 

Symbol tabs  

The Order Ticket has a maximum of four tabs, so that you can monitor and trade more than 
one symbol on a single ticket.  

 
The tabs are color-coded: 

Red (burgundy) tab = short 

Green tab = long 

Black tab = working order with no position 

A thermometer representing the current market standing of the symbol as well as the symbol 
are displayed on each tab. The thermometer is a graphic indicator of the current market 
standing relative to its opening, high, and low prices. It shows the High to Last (Red), Low to 
Last (green), and Open (yellow triangle) for that symbol for the current day. The close or last 
price is indicated by the change of color from red to green. If the thermometer displays all 
yellow, then data is either unavailable or incomplete. 

Net change is displayed to the right of the tabs. 

To see all of the tabs, then click and drag the dotted splitter line: 

 
To add a symbol to a tab 
With fewer than four tabs are in use, the next tab (+) is blank. 

1. Click the blank tab. The tab displays the symbol of the previous tab. 

2. Start typing a symbol. This field is displayed:  

 . 

3. When you have finished typing the symbol, Enter. The tab displays the symbol. 
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To change the symbol on a tab 
1. Click the tab. 

2. Start typing the symbol. This field is displayed:  

 . 

3. When you have finished typing the symbol, ENTER. The tab name is changed. 

To remove a tab 
1. Right-click the tab you want to remove. 

2. Click Close tab. 

Current working order, position, and OTE  

The Order Ticket displays the current position and Open Trade Equity (OTE) or OTE +PL (closed 
profits and losses for the day) for the selected symbol and account just below the tabs. If there 
is no position for this account yet, the display says, "No position." 

To the left of the position is the number of working buy orders. On the right of the OTE is the 
number of working sell orders. 

20 working buy lots, short, profit, 10 working sell lots: 

 
10 working buy lots, long, profit, no working sell lots: 

 
 

Right-click the position details to reverse or liquidate the position. 
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Order Ticket 

DOM area 

This area resembles the DOMTrader. 

 
 

On the Order Ticket, however, you must use the buy and sell buttons to place orders; you 
cannot drag and drop a price. 
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Buy and sell buttons  

Click one of these buttons to place an order. Buttons are labeled with order details. 

 
 

Order entry field  

This field allows you to enter orders using your keyboard, including comments. 

 
 

Enable order comments in Display Configuration preferences. 
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Order Ticket 

Size buttons  

The size buttons at the bottom of the Order Ticket allow you to change the quantity that is used 
when you place orders. The quantity values are set in preferences. 

 
The entry box displays the current order quantity.  

In increment/decrement mode: 

• Click a button to add that number of lots to the order size (in the entry field). For 
example, if the order size is 1, click 5 to change that size to 6. 

• Right-click a button to subtract that number of lots from the order size. 

• Right-click the order size to return to the default size. 

In replacement mode: 

• Click a button to change the order size to that number of lots. For example, click 10 and 
the order quantity is 10. 

• Right-click the order size to return to the default size. 

• Set the mode in preferences. 

You can also type a number to override the default.  

When trading in units, a U button is visible on the left of the size entry box. Click the button to 
switch from lots to units. 

 
 

Units order size can include two decimal places. 

Standard rounding is used. For example:  

0.33*10 units = 3.3 = rounded to 3 lots  

0.35*10 units = 3.5 = rounded to 4 lots 

Price field  

 
Either enter a price in the Price field or use the – and + buttons to increment and decrement 
the price. 

Go to Setup > Preferences > Order Placement and select Price Entry to view these 
buttons. 
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Order duration menu  

 
DAY, GTC (good-till-cancelled), GTD (good-till-date), FAK (fill and kill), FOK (fill or kill), and 
ICBRG (Iceberg) are the order duration options.  

• DAY is the default. If a DAY order is unfilled at the close of the trading session, it is 
automatically canceled.  

• GTC orders are left open until canceled by the trader.  

• GTD orders are left open until the close of the exchange’s trading session on the date 
the trader specifies. 

• FAK orders are used to buy or sell a quantity at a limit price. If the entire order is not 
immediately filled, the remaining quantity is cancelled.  

• FOK orders require that the entire quantity be executed immediately or the order is 
cancelled.  

• ICBRG orders are limit DAY or GTC orders that have both a total quantity and a display 
quantity that is shown publicly on the order book. These orders must be enabled in 
preferences.  

Parked option  

 
The Parked checkbox allows you to place an order but not submit it to the exchange right 
away. The settings for Duration and Fill are applied to the parked order(s) if the checkbox is 
filled. If it is cleared, the order placed isn’t parked.  
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Stop management menu  

 
 

Stop, Stop Limit, DOM Triggered Stop, and DOM Triggered Stop Limit are the stop management 
options that you can choose on this menu.  

• Stop is the default. A stop order becomes a market order when the stop price is hit and 
a stop-limit order becomes a limit order when the stop price is hit.  

• Stop Limit orders allow the trader to set a difference between the stop price and the 
limit price.  

• DOM Triggered Stop and DOM Triggered Stop Limit orders behave like stop orders, 
but are not triggered until the bid/ask quantity falls below the order’s trigger quantity 
(DOM threshold). You must be enabled for these “smart order” types. 

Offset field 

 
If Stop Limit is selected on the stop management menu, then an offset field is displayed. Either 
type the offset or use the + and – buttons to select the value. 

Trailing management menu  

Trade trailing limits or stops using this menu. 

 
 

Trailing limit orders track the market and automatically adjust the price level position in the 
exchange’s order book. For a buy order, as the best bid/offer/trade (depending on your 
settings) moves up, your order moves up with it based on the trailing offset. When the best 
bid/trade/offer trade moves down, your order holds. When the best bid/offer/trade matches 
your order price, the order executes. 

Trailing stop orders adjust their trigger price in concert to the direction of the market on a tick-
by-tick basis, initially trailing the market with the same distance to the market price when the 
order is first placed. The trigger price of a trailing sell stop order automatically steps higher with 
the market for each up tick, but does not step lower.  

You must be enabled for these “smart order” types. 
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Manual fills button  

You have the ability to enter fills manually for those trades that did not occur through CQG 
Trader to be reconciled against the statement. All electronic and pit contracts can be entered. 
Once the statement for the day is received, the manual fills are reconciled against the 
statement and then permanently removed.  

Click this button to indicate the next order you place is a manual fill:  

In order to enter manual fills, go to Setup > Preferences > Order & Position Settings and 
select the Enable Manual Fills check box. 

Learn how to enter a manual fill 

Special orders button  

 
 

• OCO: A multi-part order. If one part of the order is executed, then all other parts are 
cancelled. 

• BRKT: A type of order-places-order (OPO) where filling, for example, a buy order 
triggers a sell OCO - a profit target order and a stop loss order. If one of those orders is 
filled, then the other order is cancelled.  

You must be enabled for these “smart order” types. 

Learn how to place an OCO order 

Learn how to place a bracket order 

Compression button 

 
Symbols HUE, NGE, RBE, HOE, PLE, and NGH can be compressed, which means that ticks can 
be viewed in a quantity different from the exchange default. The default value for compression 
is five. Click the compression button to turn compression on and off.  

Data is aggregated in the opposite direction of the market. Bids are aggregated down, and asks 
are aggregated up. The daily high price is rounded up, and the daily low price is rounded down. 

Actual ticks, and not compressed ticks, are used for the offset value for stop limit orders. Order 
types are also determined by actual ticks. 

Orders with fixed prices are visible. 
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Split Market tool  

Click this button to move from no compression to maximum compression. Right-click to move 
the other way. 

There are four compression modes: 

 No compression (default). 

 Compress to hide gap but show nearest best bid and ask prices: price rows are 
hidden if they are between the price in DOM ladder below best bid  and the price 
above the best ask. 

 Compress to hide market gap: price rows are hidden if they are between the best 
bid and best ask. 

 Compress to hide empty prices: price rows are hidden if they are between rows 
with DOM values. All bids and asks are displayed without gaps. 

This tool is displayed by default. To remove it, go to Trading Preferences > Order 
Placement > Enable Split Market tool. 

Cancel buttons  

These buttons below the DOMTrader grid are used to cancel groups of orders. The number of 
orders that will be canceled by each button is displayed on the button in parentheses.  

 
 

• X Buys = cancel all buy orders for current symbol for this account. 

• X Sells = cancel all sell orders for current symbol for this account. 

• X All = cancel all orders for current symbol for this account. 

• X Global = cancel all orders for all accounts 

• X All/Liq All: cancel all orders and liquidate all positions for the current account. 

Go to Setup > Preferences > Display Configuration and select Enable liquidate and 
reverse buttons to view the cancel buttons. 
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Resizing Window Elements 
The Order Ticket areas can be re-sized using the splitter bar between the DOM area and the 
buttons. 

Place your mouse cursor over the splitter bar, so that it becomes a two-sided arrow. Drag the 
bar until you have the configuration you want. 
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DOMTrader 
Market transparency is vital for trading on the electronically-traded futures markets. 
DOMTrader provides that market transparency as well as the order routing functionality traders 
need. 

The DOMTrader is comprised of a depth-of-market ladder that displays a range of bid and offer 
prices; the best bid and offer with size; and trading tools, including order type selectors, buy 
and sell buttons, quantity buttons, and cancel buttons. 

In Order Placement preferences, you choose whether to display the DOMTrader or the Order 
Ticket. 

Adding a DOMTrader 
Up to three DOMTraders can be added to the CQG Trader window.  

To add a DOMTrader: 

1. Click View. 

2. Click Add DOMTrader view. 
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DOMTrader Components 
Some of the DOMTrader components are optional and are displayed based on the preferences 
you have set up. 

To check or change those preferences, click Setup on the menu bar, click Preferences, and go 
to the Order Placement tab. 

Title bar  

The DOMTrader title bar displays the symbol and account number.  

 
 

Learn how to change accounts 

Symbol tabs  

The DOMTrader has a maximum of four tabs, so that you can monitor and trade more than one 
symbol on a single DOMTrader.  

 
The tabs are color-coded: 

Red (burgundy) tab = short 

Green tab = long 

Black tab = working order with no position 

A thermometer representing the current market standing of the symbol as well as the symbol 
are displayed on each tab. The thermometer is a graphic indicator of the current market 
standing relative to its opening, high, and low prices. It shows the High to Last (Red), Low to 
Last (green), and Open (yellow triangle) for that symbol for the current day. The close or last 
price is indicated by the change of color from red to green. If the thermometer displays all 
yellow, then data is either unavailable or incomplete. 

Net change is displayed to the right of the tabs. 

To add a symbol to a tab 
With fewer than four tabs in use, the next tab (+) is blank. 

1. Click the blank tab. The tab displays the symbol of the previous tab. 

2. Start typing a symbol. This field is displayed:  

 . 

3. When you have finished typing the symbol, ENTER. The tab displays the symbol. 
 



Fore
xxin

/Cas
ey

  Page 23 

CQG Trader User Guide 

To change the symbol on a tab 
1. Click the tab. 

2. Start typing the symbol. This field is displayed:  

 . 

3. When you have finished typing the symbol, ENTER. The tab name is changed. 

To remove a tab 
1. Right-click the tab you want to remove. 

2. Click Close tab. 

Current working order, position, and OTE  

DOMTrader displays the current position and Open Trade Equity (OTE) or OTE +PL (closed 
profits and losses for the day) for the selected symbol and account just below the tabs. If there 
is no position for this account, the display states "No position."  

To the left of the position is the number of working buy orders. On the right of the OTE is the 
number of working sell orders. 

5 working buy lots, long, profit, no working sell lots: 

 
No working buy lots, short, profit, 1 working sell lot: 

 
 

Right-click the position details to reverse or liquidate the position. 
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Order duration menu  

 
 

DAY, GTC (good-till-cancelled), FAK (fill and kill), FOK (fill or kill), and ICBG (iceberg) are the 
order duration options that you can choose on this DOMTrader menu.  

• DAY is the default. If a DAY order is unfilled at the close of the trading session, it is 
automatically canceled.  

• GTC orders are left open until canceled by the trader.  

• FAK orders are used to buy or sell a quantity at a limit price and if the entire order is 
not immediately filled the remaining quantity is cancelled.  

• FOK orders require that the entire quantity be executed immediately or the order is 
cancelled.  

• ICBRG orders are a limit DAY or GTC orders that have both a total quantity and a 
display quantity that is shown publicly on the order book. These orders must be enabled 
in preferences. 

Stop management menu  

  
 

Stop, Stop Limit, DOM Triggered Stop, and DOM Triggered Stop Limit are the stop management 
options that you can choose on this DOMTrader menu.  

• Stop is the default. A stop order becomes a market order when the stop price is hit.  

• Stop Limit orders allow the trader to set a difference between the stop price and the 
limit price. A stop-limit order becomes a limit order when the stop price is hit. 

• DOM Triggered Stop and DOM Triggered Stop Limit orders behave like stop orders, 
but are not triggered until the bid/ask quantity falls below the order’s trigger quantity 
(DOM threshold). You must be enabled for these “smart order” types. 
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Trailing management  

Trade trailing limits or stops using this menu. 

 
 

Trailing limit orders track the market and automatically adjust the price level position in the 
exchange’s order book. For a buy order, as the best bid/offer/trade (depending on your 
settings) moves up, your order moves up with it based on the trailing offset. When the best 
bid/trade/offer trade moves down, your order holds. When the best bid/offer/trade matches 
your order price, the order executes. 

Trailing stop and stop limit orders adjust their trigger price in concert to the direction of the 
market on a tick-by-tick basis, initially trailing the market with the same distance to the market 
price when the order is first placed. The trigger price of a trailing sell stop order automatically 
steps higher with the market for each up tick, but does not step lower.  

You must be enabled for these smart order types. 

Manual fills button  

You have the ability to enter fills manually for those trades that did not occur through CQG 
Trader to be reconciled against the statement. All electronic and pit contracts can be entered. 
Once the statement for the day is received, the manual fills are reconciled against the 
statement and then permanently removed.  

Click this button to indicate the next order you place is a manual fill:  

In order to enter manual fills, go to Setup > Preferences > Order & Position Settings and 
select the Enable Manual Fills check box. 

Learn how to enter a manual fill 
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Special orders button  

The Special Orders menu provides options for order-cancels-order and bracket order types. 

 
 

• OCO: A multi-part order. If one part of the order is executed, then all other parts are 
cancelled. 

• BRKT: A type of order-places-order (OPO) where filling, for example, a buy order 
triggers a sell OCO - a profit target order and a stop loss order. If one of those orders is 
filled, then the other order is cancelled.  

You must be enabled for these “smart order” types. 

Learn how to place an OCO order 

Learn how to place a bracket order 

Compression button 

 
Symbols HUE, NGE, RBE, HOE, PLE, and NGH can be compressed, which means that ticks can 
be viewed in a quantity different from the exchange default. The default value for compression 
is five. Click the compression button to turn compression on and off.  

Data is aggregated in the opposite direction of the market. Bids are aggregated down, and asks 
are aggregated up. The daily high price is rounded up, and the daily low price is rounded down. 

Actual ticks, and not compressed ticks, are used for the offset value for stop limit orders. Order 
types are also determined by actual ticks. 

Orders with fixed prices are visible. 
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Split Market tool 

Click this button to move from no compression to maximum compression. Right-click to move 
the other way. 

There are four compression modes: 

 No compression (default). 

 Compress to hide gap but show nearest best bid and ask prices: price rows are 
hidden if they are between the price in DOM ladder below best bid  and the price 
above the best ask. 

 Compress to hide market gap: price rows are hidden if they are between the best 
bid and best ask. 

 Compress to hide empty prices: price rows are hidden if they are between rows 
with DOM values. All bids and asks are displayed without gaps. 

This tool is displayed by default. To remove it, go to Trading Preferences > Order 
Placement > Enable Split Market tool. 

Expand button  

 
If the DOMTrader is sized so that not all of the buttons are visible, an expand button appears 
on the right side. Clicking this button displays the hidden components. To display the hidden 
component(s), click it, then click the DOMTrader to the left of the expand button. The hidden 
component replaces one of the other components. To see all components, resize your 
DOMTrader. 

Buy and sell buttons  

One of the ways to place a market order is by clicking the Buy and Sell Market order buttons 
at the top of the DOMTrader.  

 
 

Go to Setup > Preferences > Order Placement and select the Buy/Sell Market buttons 
check box to view the buy and sell buttons. 
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Order type indicator  

If fast-click mode is selected in preferences, the order type button is displayed between the buy 
and sell buttons. The button displays the applicable limit or stop icon depending on the settings 
for the current symbol, such as: 

 
If an order is being placed using drag and drop, the order type is determined by whether the 
price is above or below the market, and which column, buy or sell, the order is dropped into. 

Cancel buttons  

These buttons below the DOM ladder are used to cancel groups of orders. The number of orders 
that will be canceled is displayed on the button in parentheses.  

 
 

• X Buys = cancel all buy orders for current symbol for this account. 

• X Sells = cancel all sell orders for current symbol for this account. 

• X All = cancel all orders for current symbol for this account. 

• X Global = cancel all orders for all accounts 

• X All/Liq All: cancel all orders and liquidate all positions for the current account. 

Go to Setup > Preferences > Display Configuration and select the Enable liquidate and 
reverse buttons check box to view the cancel buttons. 

To hide the buttons, click the arrow button under the buttons. 
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Size buttons  

The size buttons at the bottom of the DOMTrader allow you to change the quantity that is used 
when you place orders. The quantity values are set in preferences. 

 

 
 

The entry box displays the current order quantity.  

In increment/decrement mode: 

• Click a button to add that number of lots to the order size (in the entry field). For 
example, if the order size is 1, click 5 to change that size to 6. 

• Right-click a button to subtract that number of lots from the order size. 

• Right-click the order size to return to the default size. 

In replacement mode: 

• Click a button to change the order size to that number of lots. For example, click 10 and 
the order quantity is 10. 

• Right-click the order size to return to the default size. 

• Set the mode in preferences. 

You can also type a number to override the default.  

When trading in units, a U button is visible on the left of the size entry box. Click the button to 
switch from lots to units. 

 
 

Units order size can include two decimal places. 

Standard rounding is used. For example:  

0.33*10 units = 3.3 = rounded to 3 lots  

0.35*10 units = 3.5 = rounded to 4 lots 
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The DOMTrader Ladder 
The DOMTrader ladder consists of price, volume, buy, and sell columns. The ladder displays 
market data and order information. You can trade directly on the ladder too. 

Price column 

 
 

The center column on the DOMTrader ladder is the price column. This column is always 
displayed.  

The best bid and best ask are indicated by green and red highlighting. Notice the black 
rectangle around those prices; it highlights the spread between the best bid and best offer. This 
highlighting is helpful when the best bid and ask are separated by several prices. 

Recent trade sequence is represented by circles of varying size indicating the prices that 
have been active most recently. The larger the circle, the most recently that price was traded. 
Recent trade sequence is optional. To add recent trade sequence to the display, go to Setup > 
Preferences > Order Placement and select the Recent Trade Sequence check box. 
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The last trade indicator shows whether the last trade was higher (up arrow) or lower (down 
arrow) than the previous trade. If the last trade was at the same price as the previous trade, 
then no arrow is displayed. 

Pre-open indicative volume and price are represented like this:  

 
The ladder also displays an open position indicator that corresponds to the average open 
position price (green for long position, red for short position): 
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Depth of Market (DOM) column  

 
 

The column to the immediate right of the price column is the Depth of Market column. 

The data in this column is continuously updated while the market is active.  

This column is optional. To display it, go to Setup > Preferences > Order Placement and 
select the Order Book for each price check box. 
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Order columns 

 
 

The columns to the far left and the far right of the ladder are the order columns. These columns 
are always displayed.  

Watermarks, seen here as STP and LMT, are optional. Other options include order quantity and 
buy/sell. To display watermarks, go to Setup > Preferences > Order Placement and select 
the Show watermark check box. 

When you drag a price to either column, a visual representation of your order is displayed. 
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Market lines 

 
 

DOMTrader displays three market lines: high, low, and market. The green and red lines 
represent the maximum and minimum trade prices for the contract during the current trading 
day. 

If there are valid best bid and best ask values, and the best ask is equal to the best bid plus 
tick size value, the market line is displayed. If best bid or best ask prices are not valid for the 
contract, of if there is a gap between the best bid and best ask rows, the market line is not 
displayed. 



Fore
xxin

/Cas
ey

  Page 35 

CQG Trader User Guide 

Market window 

 
 

When you scroll to a price that is far enough from the current market value that the current 
market value would normally scroll off the screen, the system prevents that from happening. 

The line across the DOMTrader ladder (in this case, under 117675) indicates that the market 
window is above the selected price. Every time the current market price changes, the market 
window re-centers the market price row, so that it is always displayed. 

The market window is two rows by default. To change the size of the window, drag and drop 
the market window line (cursor becomes a double arrow), as shown in this image: 
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If the best bid and best ask are both displayed on the DOMTrader and market movement 
results in DOMTrader not being to accommodate both (too great a spread), then an indicator is 
displayed between the two. It lets you know that there are prices missing, so that you can see 
both best bid and ask on the ladder. Notice the gap in this image: 

 

 



Fore
xxin

/Cas
ey



Fore
xxin

/Cas
ey

  Page 39 

CQG Trader User Guide 

Out of view orders 

 
When you scroll up or down the DOMTrader and your working orders are no longer visible, this 
bar is displayed. Click the square to jump to the order. Click this square each time you want to 
jump to the next order that is out of view. 
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Setting Trading Preferences 
Preferences include: 

• Order and Position Settings govern order behavior, such as whether stops or stop 
limits should be used as a default; what the default visible size value should be for 
iceberg orders; and what the maximum values for order and position size should be to 
minimize risk. 

• Display Configuration parameters govern if and how elements are displayed on the 
trading applications, quote board, and Orders and Reports window. 

• Order Placement settings govern the choice of trading application, the display (buttons 
and columns), and the enablement of order placement options. 

• Notifications allow you to identify when and how you are notified of events relating to 
your system and orders. 

To set preferences, click Setup and then click Preferences.  
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Setting Order & Position Preferences 
These settings allow you to select a default stop type, set parameters for smart order types, 
establish offset and range, select risk parameters, identify the quantity for the size buttons, set 
how OTE/MVO and entries and exits are calculated, enable manual fills, and select the behavior 
of size buttons. 

Symbol Settings 

 
 

First, choose whether you wish to configure these symbols according to lots or units. Separate 
values are stored for both lots and units. If units is selected, then ICBRG visible size and DOM 
threshold are defined in units for ICBRG and DOM-triggered orders and for bracket orders. 

Then, working across each row, set stop action, smart order types, order options, and risk 
settings: 

 
Stop Action 
Select STP or STL for each symbol listed. This sets the default action when you use the 
keyboard to place a buy or sell order. Once the default is set, you can still place the order type 
you did not select. The CTRL key allows you to toggle between the two order types. 
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Smart Order Types 
Select the check boxes to enable trailing, DOM-triggered stops, iceberg, and bracket orders.  

To set default parameters for each type, click the order type icon. Preferences are stored by 
instrument and account. For example, if you click the trailing icon, you can then choose 
whether orders trail the current bid and offer or last trade: 
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Order Options 

Type values for offset and range.  

Offset sets the number of ticks between the stop and limit prices on stop limit orders.  

Range sets the threshold in number of ticks for a warning that is given if buy orders are placed 
above the current market, or if sell orders are placed below the market. 

The stop limit offset determines the limit price for the order the stop limit becomes when the 
stop price is hit. 

You can use the offset field on the Order Ticket also. 

Risk Settings 

Set maximum order size, maximum position size, default order size, and second default order 
size. 

Maximum Order Size sets the maximum quantity for orders placed on this symbol. This setting 
does not prevent you from exceeding the limit you set, but warns you if you attempt to exceed 
it.  

Maximum Position Size sets the maximum position size for orders placed on this symbol. This 
setting does not prevent you from exceeding the limit you set, but warns you if you attempt to 
exceed it.  

Default order size is reflected in the size entry field after right-clicking. 

The second default order size is used when placing fast-click orders with the middle mouse 
button. If the second default order size is equal to zero, then you cannot place an order by 
middle mouse click. 

Decimals are allowed for order size. 

Order Button Settings 

 
 

First, choose whether you wish to configure these symbols according to lots or units. Separate 
values are stored for both lots and units. 

Then, enter values for order quantity buttons.  

For FX futures values, K = thousand, M = million, and B = billion. Quantities greater than 4 
digits should be abbreviated. 

Default values are: 1, 5, 10, 20, 50, 100 for futures and 1M, 5M, 10M, 20M, 50M, 100M. 
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Calculating OTE/MVO by 

 
 

Select whether Open Trade Equity (OTE) and Market Value of Options (MVO) are calculated by 
Last Trade or by Best Bid/Ask. 

Match Entries and Exits by 

 
 

Select whether Entries and Exits are matched by First In/First Out (FIFO) by selecting either 
FIFO – Intraday First or FIFO. 

Fill Mode 

 
 

Select the first check box for the ability to enter manual fills. 

Select the second check box to group strategy leg fills as strategies in the fills report, otherwise 
the report displays fills by leg. 

Quantity Entry Behavior 

 
 

Choose whether order quantity buttons when clicked should replace the existing quantities or 
increment and decrement the existing quantities. 
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Setting Display Configuration Preferences 
These settings allow you to choose which data, buttons, and columns are included in trading 
application and Orders and Positions windows. 

Order Placement Display 

 
Buy column placement 
Select whether you want to display the buy column to the right or the left (default). 
Display open trade equity 
Select this check box to display OTE, then select either only OTE or OTE & P/L. 
Highlight digits in price scale 
Choose whether to highlight a certain number of digits in the price, and then decide how many. 
This image shows three highlighted digits: 

 

Orders and Positions Settings 
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Display OTE/MVO 
Choose the currency to be used in OTE calculations. This setting applies only to the Orders and 
Reports Account Summary window and the title bar of the Orders and Report window. Other 
controls and windows use US dollars for open trade equity, unrealized profit/loss, market value 
of options, and profit/loss. 

Also select the interval for updating OTE, margin excess, and total purchasing power values. 
Options are 5, 10, 15, and 30. Default is 10. 
Display total OTE+P/L 
Select this check box to display OTE & P/L on the title bar. In this image, it’s displayed as a 
percentage of account summary, rather than as a currency value: 

 
Enable liquidate and reverse buttons 
Select this check box to include the X and R buttons on the Opens Positions window. 

 

Order Comments 

 
 

Choose to allow order comments. Learn about entering orders with comments. 
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Quote Display 

 
 

Choose whether to include net change, total traded volume, or both on the Quote Board: 

 
 

Units 

 
 

Select this check box to trade in units rather than lots.  

Click the … button to locate the xml conversion file you’ll be using to define units.  

Click the View button to open the conversion table. Note that this button is active only if a 
valid conversion table is selected and the Enable check box is selected. 
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Order Display Columns 

 
 

• From the drop down menu, select the order tab you want to customize. 

• Select the check boxes for the columns you would like displayed.  

• Unselect the check boxes for the columns you wish to remove. Use the Clear button to 
unselect them all. 

• Use the Move to Top, Move Up, and Move Down buttons to change the order of the 
columns. 
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Setting Order Placement Preferences 
These settings allows to you choose whether to use the DOMTrader or the Order Ticket for 
order placement, which columns and buttons to display on the trading applications, and which 
order placement methods should be enabled. You can also choose the price scale behavior for 
DOMTrader and font size for the Order Ticket. 

DOMTrader or Order Ticket 

 
 

Click the button for either DOMTrader or Order Ticket to choose which is displayed in CQG 
Trader.  

DOMTrader or Order Ticket Columns  

  
 

Select or unselect the check boxes to choose the columns that are included on the DOMTrader 
or Order Ticket. 
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DOMTrader Price Scale  

 
For a dynamic price scale, select the Dynamic Price scale button. The current price stays 
centered on the DOMTrader window. 

Split Market Tool 

 
This tool is on by default. To remove the Split Market tool from the display, unselect the check 
box.  

Learn more about the Split Market tool 

Function Buttons  

Select the check boxes to choose the buttons to include on the DOMTrader or Order Ticket.  

DOMTrader: 

 
 

Order Ticket: 
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DOMTrader Order Placement Methods  

 
Select or unselect the check boxes to enable Fast-Click, keyboard trading, and sweep mode. 

Order Ticket Font Size  

 
Select Small, Medium, or Large font size. 
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Setting Notification Preferences 
These settings allow you to control whether and how you are notified of connection issues and 
order-related actions (fills, acknowledgements, rejects). You can also set specialized 
notifications, such as warning of potential cross trades, warning of actions that apply to multiple 
orders and positions, and prompting for order cancellation when you log off. 

Connection Status  

 
Select this check box to be notified when order routing is slow. 

Order Sounds  

 
Select these check boxes to play a sound when an order is filled, when an order is 
acknowledged, and when an order is rejected. Click the browse button (…) to search and select 
a sound file to play. Click the Test button to hear the sound. 
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Notifications 

 
Select these check boxes to be notified of every fill, when a warning is received, when an order 
is rejected, and when an information message is received. 

You also be alerted of delays in order actions: order acknowledgement, market order fill, and 
order cancellation. These check boxes are selected by default. You can enter a second value 
between 1 and 99. A delay in acknowledgement can occur either before or at the exchange; the 
notification alerts you to which has occurred. 

Order Placement 

 
 

Select the messages you want to receive when you place orders.  

When cross trade checkbox is selected, you receive a warning when placing orders that might 
match another order placed from one of your accounts.  
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Purchasing Power 

 
 

Purchasing power is displayed on the Account Summary pane. It is the sum of total margin 
value, OTE, and MVO. 

Select the first check box, Enable automatic Purchasing Power update, to allow the system 
to automatically update purchasing power, margin excess, and total margins values. Automatic 
updates occur only if the Account Summary window is active. The values are updated when 
you switch to the Account window from another window; when a fill, fill busted, or fill cancelled 
transaction occurs; when a day statement environment change occurs; when a current balance 
environment change occurs; and when the quantity of working orders changes. 

Select the second check box, Enable manual Purchasing Power update, to allow manual 
updates. To manually update the values, click the Account Summary tab. 

Select the third check box, Highlight Margin Excess if less than, to highlight margin excess 
when it is some percent (1-100) of the net liquidity value or as a minimum currency value. This 
check box is active only if manual updates are enabled. The default is on with a value of 10% of 
NLV. 
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Using Key Action Help 
There are two profiles for Key Action Help: CQG Trader Defaults and CQG Updated. Switch 
between the profiles using the menu at the bottom left of the page. 

Defaults are the keyboard shortcuts you’ve been using. The newer updated shortcuts differ in 
these areas: 
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Getting Started 
 

Before you begin trading, it helps to know how to enter symbols and choose accounts. You 
should also familiarize yourself with order types, order sizes, and DOMTrader modes. 

Traders working with units rather than lots will find details about configuring the xml conversion 
file and other information about units trading. 
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Entering Symbols in CQG Trader 
You can enter futures, exchange-traded spreads, currencies, options, and equities in CQG 
Trader. 

Entering futures 

The format for futures is: F.<symbol><month code><year> 

Month codes: 

F January N July 

G February Q August 

H March U September 

J April V October 

K May X November 

M June Z December 

 

For currently traded (non-expired) contracts, the lead digit of the year can be omitted, e.g. 
USAZ11.  

Example: SPU11 = September 2011 S&P 500 futures contract 

For the most active futures contract, type the symbol and ?. 

For the first non-expired futures contract, type the symbol and ?1. For the second non-
expired futures contract, type the symbol followed by ?2. For the seventh non-expired futures 
contract, type the symbol followed by ?7. Follow this pattern for all numbers. 

Symbol entry connects with commodity symbols before contracts. Therefore, entering SF 
displays the lead month for Swiss Francs, rather than January soybeans. To get the soybean 
chart, you would need to type in the year (SF11, for example). 
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Entering exchange-traded spreads 

Currently, CQG Trader supports eCBOT reduced tick spreads only.  

A calendar spread is a simultaneous buy and sell orders for the same commodity with different 
delivery months. Reduced tick spreads are a version of the calendar spread has a smaller 
minimum tick size movement than that available in other strategies or outright markets.  

The format for reduced tick calendar spreads is: <symbol root><R><strategy leg 
gap><month><year> 

The strategy leg gap = 1, 2, 3, 4, 5, 6, or 12 or by demand. 

Example: US 5-Year Treasury Note: FVAR1V11 (represents FVAV11-FVAX11). 

Entering currencies 

The format for cash, currencies, indices, and reports is: X.<symbol> 

Example: X.FXEURUSD = Euro/USA 

Entering options 

The format for options on futures is: C.<symbol><month code><year><strike price> for 
calls and or P.<symbol><month code><year><strike price> for puts. 

The strike price is 2-5 digits. 

Example: C.SPZ111500 = December 2011 1500 call on the S&P 500 futures contract. 

An alternate format is C.<symbol>_<month code><year>.<strike price> for calls and with P. 
for puts. 

Example: C.SP_U11.1500 = September 2011 1500 call on the S&P 500 futures contract. 

For at the money for the nearby month, type C. or P., the symbol, and ?. 

For at the money for some other month, type C. or P., the symbol, the month, the year, 
and ? and then press CTRL+ENTER. 

For strikes for the most active month, type C. or P. and the symbol and ? and then press 
CTRL+ENTER. 

On Options windows, you can enter the symbol only. 

On the Quote SpreadSheet, you can enter C.<symbol><month code><year> for calls and with 
a P. for puts, and then press CTRL+ENTER to view data for a series of one option class. 

Example: C.SPUZ = All September S&P 500 futures contracts. 

Entering stocks 

The format for stocks is: S.<symbol> 

Example: S.MSFT = Microsoft 
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Selecting an Account 
The Account Selector allows you to move between accounts quickly and easily for order 
placement.  

 

To change accounts 

1. Right-click the title bar of the trading window or press F5. The Account Selector 
opens. 

The account in italics is the active account. Accounts that are not available are not 
enabled. 

When the Account Selector opens, the cursor focus is in the Find Account field. 

2. Start typing the name of the account in the Find Account field. Matching names are 
highlighted character by character. 

You can type any part of the account name to search. For instance, if you know the 
account you want has an "m" in it, then type "m" and all accounts with an "m" in the 
name are displayed. 

If you have more than ten accounts, click the All Accounts button to see the 
remainder of the list. 

3. To select an account, either:  

• double-click the account; 

• use the up and down arrows to move up and down the list of accounts and ENTER to 
select the account; or 

• click an account and then click the OK button. 

To manage the Account Selector list 

To change the order of accounts on the Account Selector, drag and drop the account. 

To sort all accounts 

You can sort all accounts by Top 10, Number, FCM, and Name.  

• Click the column heading once to sort in ascending order. The arrow points up. 

• Click the column heading twice to sort in descending order. The arrow points down. 
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Order Types and Durations 
Order Types 

Type Description 

Bracket A bracket order is a type of order-places-order (OPO) 
where filling an order triggers a profit target order and 
a stop loss order OCO. 

DOM-Triggered Stop A market order that is triggered only when the inside 
market bid/ask quantity falls below the order’s trigger 
level. 

DOM-Triggered Stop Limit A limit order that is triggered only when the inside 
market bid/ask quantity falls below the order’s trigger 
level. 

DOM-Triggered Trailing Stop The DOM-triggered trailing stop combines the features 
of a DOM-triggered stop and a trailing stop. The stop 
is triggered when the market trades at the stop price 
and the resting volume in the order queue drops 
below a trader-set threshold. Then a market order is 
placed. The Sell DOM-triggered stop will automatically 
follow the market higher as the market advances, but 
not retrace if the market trades lower. The Buy DOM-
triggered stop will automatically follow the market 
down as the market declines, but not move higher if 
the market trades up. 

DOM-Triggered Trailing Stop Limit The DOM-triggered trailing stop limit combines the 
features of a DOM-triggered stop limit and a trailing 
stop limit. The stop is triggered when the market 
trades at the stop price and the resting volume in the 
order queue drops below a trader-set threshold. Then 
a limit order is placed. The Sell DOM-triggered stop 
limit will automatically follow the market higher as the 
market advances, but not retrace if the market trades 
lower. The Buy DOM-triggered stop limit will 
automatically follow the market down as the market 
declines, but not move higher if the market trades up. 

Iceberg A limit day order that has both a total quantity and a 
display quantity that is shown publicly on the order 
book.  

Limit An order at a specified price. 

Market An order at the best available current price. 

Order-Cancels-Order An OCO is a multi-part order. If one part of the order 
is executed, then all other parts are cancelled. 

Stop A market order that is triggered when the stop price is 
hit. 
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Type Description 

Stop Limit A limit order that is triggered when the stop price is 
hit. 

Trailing Limit An order that tracks the market and automatically 
adjusts its price level position in the exchange’s order 
book. For a buy order, as the best bid/offer/trade 
(depending on your settings) moves up, your order 
moves up with it based on the trailing offset. When 
the best bid/trade/offer trade moves down, your order 
holds. When the best bid/offer/trade matches your 
order price, the order executes. 

Trailing Stop Trailing stop orders adjust their trigger price in 
concert to the direction of the market on a tick-by-tick 
basis, initially trailing the market with the same 
distance to the market price when the order is first 
placed. The trigger price of a trailing sell stop order 
automatically steps higher with the market for each up 
tick, but does not step lower.  

Trailing Stop Limit An order that adjusts its trigger price in concert to the 
direction of the market on a tick-by-tick basis, initially 
trailing the market with the same distance to the 
market price when the order is first placed. The 
trigger price of a trailing sell stop order automatically 
steps higher with the market for each up tick, but 
does not step lower.  

Durations 

Time in Force Description 

Day Day orders are cancelled at the end of the trading day. 

Fill and Kill FAK orders require that any remaining quantity after a 
partial fill be cancelled. 

Fill or Kill FOK orders require that the entire quantity be 
executed immediately or the order is cancelled. 

Good-till-Cancelled GTC orders are left open until canceled by the trader. 

Good-till-Date GTD orders are left open until the close of the 
exchange’s trading session on the date the trader 
specifies. 
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Size Abbreviations 
DOMTrader quantities, order sizes, and positions are abbreviated using: 

• K= thousand 

• M = million 

• B = billion 

Any necessary rounding is done according to standard mathematical principles. The DOMTrader 
and Order Ticket display balloons with the full quantity if you hover the cursor over the value.  

DOMTrader and position quantity is abbreviated to its maximum length of three digits if it is 
more than 5 digits. 

For example:  

76,163,344 becomes 76.2M  

6,103,344 becomes 6.1M  

120,345 becomes 120K  

23,345 stays 23,345 

Order size, including iceberg display quantity, is abbreviated to its maximum length of four 
digits. 

For example:  

76,100,000 becomes 76M  

10,000 becomes 10K 

123,400 becomes 123K 

1000 stays 1000 

You are able to use these new abbreviations when you enter order size. Overflow, meaning 
when the quantity is too large to be displayed, is identified using the plus sign. For example, 
values over 2,147,483,647 are represented as “2b+”.  

These abbreviations do not apply to batch orders. 

Please note that manual fills are designated with lowercase m and not uppercase M. 
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DOMTrader Modes 
It is important to pay attention to the mode your DOMTrader is in before you place an order, as 
it affects how an order is filled. 
To place orders 
When DOMTrader is in Market mode, the cursor moves up or down as the market moves up 
and down in a liquid market. If you were to press the right or left arrow to place an order, that 
order would be a market order.  

If you click a price in the price column, the DOMTrader shifts to Place Order mode. If you were 
to press the right or left arrow to place an order, that order would be a limit or stop order. 
To move from order to order 
If you press CTRL, the DOMTrader shifts to Browse Order mode. Notice that the cells with 
orders are highlighted. Use the up and down arrows to move from one working order to the 
next. Press the space bar to see order details. To close the order details window, move the 
mouse. 
To modify orders 
In Browse Order mode, you can modify the price and quantity. To change the quantity, type a 
new quantity and ENTER. To change the price, move the order up or down the ladder using the 
arrow buttons, then ENTER. In this image, we are changing both the quantity and price: 
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Trading Units Versus Lots 
Trading in units is similar to trading in lots. The difference is that you can place large orders in 
lots as one order in units. 

For example: 

<unit commodity="F.EP" lotsInUnit="10"/> 

In this case, placing an order for 1 unit is the same as placing an order for ten lots.  

To trade in units, you first need to enable units trading and upload an xml conversion file.  

Please note that unit trading must be enabled and the conversion file must be valid in order for 
unit trading components to be active on order entry and management windows. 
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Formatting Conversion Files 

The conversion file that maps units to commodities should be formatted in this way: 
<?xml version="1.0" encoding="utf-8"?> 

<units> 

<unit commodity="string commodity name 1" lotsInUnit="integer number"/> 

<unit commodity="string commodity name N" lotsInUnit ="integer 
number"/> 

</units> 

unit commodity = commodity name with an optional instrument prefix 

lotsInUnit = number of lots in single unit, between 1 and 2,147,483,647 

 

If only one type of option is defined in the conversion file, the opposite type is added 
automatically and given the same value. For example: if the file defines only C.EP with rate 10, 
P.EP with rate 10 is added. Otherwise, each conversion rate is independent. 

Possible error types: 

• If the xml file is not accessible, you receive a message stating that file access is denied 
or the file is not found. In that case, trading in units for all commodities is disabled. 

• If the xml file has an invalid XML structure, you receive a message asking you to correct 
the errors. In that case, trading in units for all commodities is disabled and  previous 
conversion information is cleared from the Unit Sizes window. 

• If the xml file has empty commodity names, you receive a message asking you to 
correct the errors. 

• If the xml file has invalid ratio values, you receive a message asking you to correct the 
errors. In that case trading in units for these commodities is disabled. 

• If commodities are duplicated, then the first in the list is used, and you receive a 
message with a list of duplicated commodities. 

• If commodity names are invalid (for example, containing more than a prefix and 
symbol), you are notified of the invalid names. 

In the case of an error, the field is highlighted in red: 

 
 

Save this sample xml file to your machine as a way to get started creating your own conversion 
file. 

http://www.cqg.com/docs/SampleUnitsConfiguration.xml
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Viewing Unit Size Data 

The data in the conversion file can be reviewed on the Unit Sizes window. 

To open the window, click View on the Application_Name toolbar, and then click View Unit 
Sizes. Please note that this image is only an example of the type of data you’ll see. 

 
 

The Commodity column displays the commodity name or the commodity name with 
instrument prefixes. Unit sizes are sorted by commodity name. Futures are displayed without a 
prefix, while all other commodity types include prefixes. For example, C.EP. 

The Size column indicates how many lots are in a single unit.  If a conversion rate is either 
incorrect or undefined, the size field is blank and highlighted in red. 

Click the Reload button to update the information from an updated xml conversion file. This 
button is active only if trading in units is enabled in preferences.  

The Unit Sizes window is separate from the Application_Name window, so it can be viewed 
outside of the application window.  

Reloading Conversion Files 

The system automatically recognizes that an updated  conversion file has been saved and 
prompts you to reload the file: 

 
 

The file is also reloaded when: 

• you reattach the file using the browse button on the Display Configuration preferences 
window; 

• when Application_Name is restarted; and 

• when you click the Reload button on the Unit Sizes window. 
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Entering Orders 
CQG Trader offers two trading applications, the DOMTrader and the Order Ticket, both of which 
offer several effective and convenient ways to place and manage orders. 

It also offers a comprehensive list of order types and times in force that allow you to dictate the 
life of the order and provide handling instructions.  

You have a choice about whether to be notified of various order actions. Go to Notifications 
preferences to make those choices. 
Order Action Confirmations 
If you have chosen to confirm orders before they are submitted to the exchange, then expect 
messages such as: 

 
 

For units trading, the message looks something like this:  
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Placing Orders on the Order Ticket 
There are three ways to place an order from the Order Ticket window: using the Buy/Sell 
buttons, using the Order Entry field, and using the HeadsUp Display. 

To enter an order with the buy and sell buttons 

Place orders at the market, with a limit price, or for best bid or offer.  

1. Select your order type and quantity. 

2. Click your desired price to populate the buttons with that price. You can also use 
your keyboard to select a price. 

3. Click the Buy or Sell button for the type of order you want to place. For market 
orders, click a Buy @ MKT button. 

 
 

If the price is below the market, the Order Ticket displays one standard buy limit button and 
stop and limit sell buttons.  

If the price is above the market, the Order Ticket displays one standard sell limit button and 
stop and limit buy buttons, as seen in the example above.  
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To enter an order with the order entry field 

1. Either click in the Order Entry field. 

2. Enter the order details, like this: 

 
The Submit button remains grayed out until the order can be submitted. Red text 
indicates an error. If you click or tab out of the field, then the entry is cleared. 

3. Click Submit or press ENTER to place your order. 

You can also copy and paste an order by using Ctrl-C to copy and then Ctrl-V to paste.  

Format and allowed values 
Non-FIT orders should be entered in this format: 

[FCM account number] [side] [size] [instrument] [price] [order type] 
[duration] 

Abbreviated versions (add space at end of entry to activate Submit button): 

[FCM account number] [side] [size] [instrument] = market order 

[FCM account number] [side] [size] [instrument] [price] = limit order 

[FCM account number] [side] [size] [instrument] [price] [order type] = day 
order 

Order elements are separated by a space. 

Allowed values: 

FCM account number = type the account number or type # to use the current account. 

Side = B or S. 

Instrument = Short or full name. 

Price = M for market or @[price] or [price] for limit. 

Type = LMT, STOP, STL, TSTP, or TSTL.  

If STL/TSTL, then follow it with the price. 

Duration = DAY, GTC, or GTD.  

If GTD, then follow it with the date in mm/dd/yyyy format. (GTD represents 
exchange trade date and not local date or UTC.) 

If you enter a FIT instrument, then the format is: 

[FCM account number] [side] [size] [instrument] [@price] [lmt] [aggressive 
flag] [duration] 

Allowed values: 

Aggressive flag = AGGR or PASS. 

Duration = DAY, GTC, GTD, FAK, or FOK. If GTD, then follow it with the date in 
mm/dd/yyyy format. 

Entries are not case-sensitive.  
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Placing Orders on the DOMTrader 
There are three ways to place an order from the DOMTrader: using the Buy/Sell buttons, using 
the mouse or keyboard, and using the HeadsUp display. 

To enter an order by dragging and dropping a price 

1. Set the order qualifiers and quantity for your order using the buttons on the 
DOMTrader. 

2. Click and drag the price to the Buy or Sell column. The order details appear like this 
as you drag: 

 
3. If you have notifications turned on, then you receive a confirmation message. Click 

OK. Your order is placed, and the order icons are displayed on the DOMTrader 
ladder, like this: 

 
 

Note:  The price of a working order does not necessarily correspond to the cursor position at 
the time of the action, because the market may change before the exchange receives the order. 
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To enter an order with fast-click 

You can place orders in just one click if fast-click mode is activated in preferences.  

Click the buy or sell column at the desired price level.  

 
 

When you place an order using fast-click, the order type is indicated by the icon at the top-
center of the window. When you press CTRL, the icon changes to indicate a new order type. A 
fast-click order uses that order type regardless of the side and price. 

For example, suppose you have ICBG DAY set for order duration and DOM-Triggered Stop 
selected for stop management. If you place an order, the order is a DAY iceberg order. If you 
press CTRL while placing the order, the order is a DOM-Triggered Stop. 

To place a fast-click order at the second default order size, click the middle mouse button. 

To enter an order using the buy and sell buttons 

Click the buy or sell button at the top of the DOMTrader to place an order. 
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To enter an order with the keyboard 

The following button behavior is based on the default setting that buy is on the left side of the 
ladder and sell is on the right. 

About DOMTrader modes 

Market mode 

To place a buy market order, press the  (left arrow) key.  

To place a sell market order, press the  (right arrow) key.  
Place Order mode 

To place a buy limit order, press the  (left arrow) key. Price must be less than or equal to 
market price. 

To place a sell limit order, press the  (right arrow) key. Price must be greater than or 
equal to market price. 

To place a buy stop order, press the  (left arrow) key. Price must be greater than market 
price. 

To place a sell stop order, press the  (right arrow) key. Price must be less than market 
price. 

To place a buy best offer order, press  +  (ALT+left arrow) key.  

To place a sell best offer order, press  +  (ALT+right arrow) key.  

CTRL toggles between the stop and stop limit order types. A DOM-Triggered Stop Limit 
becomes a DOM-Triggered Stop, a Trailing Stop becomes a Trailing Stop limit, etc. Here, the 
current order type is assumed to be stop: 

To place a buy stop limit order, press  +  (CTRL+left arrow) key. Price must be 
greater than market price. 

To place a sell stop limit order, press  +  (CTRL+right arrow) key. Price must be 
less than market price. 

 The price associated with the order placed does not necessarily correspond to the best bid or 
ask position at the time of action, as the market and DOM data may change before the 
exchange receives the order. 
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Quick reference DOMTrader order entry 

 

Order Type Using Keyboard Using Mouse 

buy market left arrow  

 

Click buy market button. 

sell market right arrow  

 

Click sell market button. 

buy limit left arrow  

 

Select price less than or equal to market and drag and drop it 
in buy column. 

 

sell limit right arrow  

 

Select price greater than or equal to market and drag and 
drop it in sell column. 

 

buy stop left arrow  

 

Select price greater than market and drag and drop it in the 
buy column.  

sell stop right arrow  

 

Select price less than market and drag and drop it in the sell 
column. 

buy stop 
limit 

CTRL + left arrow 

 +  

(Must use drag and drop.) 

sell stop 
limit 

CTRL + right 
arrow 

 +  

(Must use drag and drop.) 

buy best 
offer 

ALT + left arrow 

 +  

Drag and drop best offer price in the buy column. 

sell best 
offer 

ALT + right arrow 

 +  

Drag and drop best offer price in the sell column. 
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To stack orders 

You can place orders at the same side of the market, for the same price, and for the same 
commodity, but with different order types by creating a stacked order. 

Drag and drop the orders in the same price field. You can also use the keyboard. 

Double-click the stacked order icon to see the details for individual orders. You can also press 
[+] on your numeric keyboard. Pressing [-] closes the details. 

In this image, there are three sell orders for total quantity of 65: 
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Entering Orders Using HeadsUp 
The HeadsUp display is the same on both the DOMTrader and the Order Ticket. 

 
 

1. Right-click the price. HeadsUp is displayed as long as you continue to press the 
mouse button. 

2. Drag the cursor to the circle that identifies the type of order you wish to place. If 
there are additional options for that order type, smaller circles are displayed. 

3. Release the mouse button. The order is placed. 
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Entering Orders with Comments 
You can add a comment to an order when you enter the order using keyboard order entry on 
the Order Ticket or when you confirm the order. 

Go to Setup > Preferences > Display Configuration and select Enable order comments.  

To add a comment with keyboard order entry 

Type // after the order followed by the comment text, like these: 

 
 

Notice the comment on the working order information: 
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To add a comment on the order confirmation window 

In order to enter comments on this window, notifications must be turned on in preferences. 

 
 

1. Type your comment. 

2. Click Yes. 
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Entering Sweep Orders 
You have the ability to place sweep orders on the DOMTrader. This feature allows traders to 
place an order with a quantity totaling the aggregated depth quantity. 

Go to Setup > Preferences > Order Placement > Order Placement Methods to enable sweep 
orders. 
To place a sweep order 

1. Click a quantity in the DOM column and drag it to the appropriate order column. 

Before you release the mouse button, the order quantity and price are displayed like 
this: 

 
 

Note that the quantity is equal to the aggregate bid or ask depth (662 = 116 + 206 
+ 115 + 149 + 76). The quantity continues to update as long as you do not release 
the mouse button.  

2. Release the mouse button. The order appears in the order column. 
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Entering Manual Fills 

1. Click the Manual Fills button . It turns orange, like this: . 

2. Enter an order. The Add Manual Fill window opens populated with the order details. 

 
 

3. Verify that the side, quantity, symbol, and price are accurate. 

4. If you are trading in units, select Units. 

 
5. Enter the fill time. 

6. Click the Add button. Manually filled orders are displayed on the Orders and Reports 
window. 

 

In order to enter manual fills, go to Setup > Preferences > Order & Position Settings and 
select the Enable Manual Fills check box. 



Fore
xxin

/Cas
ey

Page 86 

Entering Orders 

Entering Order-Cancels Order (OCO) Orders 
1. On the special orders menu, verify that OCO is selected. 

2. Click the OCO button. It turns orange.  To exit OCO mode before placing an 
order, right-click the button. 

3. Enter the first order. Notice that order details indicate the compound order has not 
been submitted: 

 
4. Enter the second order. 

5. Continue to place orders for each part of the desired OCO. 

6. Click the OCO button. You receive an order confirmation message for each of the 
orders and for the OCO. 

 
 

Upon execution of one of the orders, the other order(s) are cancelled automatically. 

To add an order to an existing OCO or to create an OCO from existing orders, use the Order & 
Report pane. 
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Entering Bracket Orders 
A bracket order is a multiple leg order-places-order (OPO). The first leg is an order with any 
regular order type (main leg). The second leg has two legs. The first leg is a limit or iceberg 
target order (profit leg) and the second leg is a stop order (loss leg). 

Filling or partially filling the main leg triggers an OCO of the second leg, which has two legs 
itself - a profit leg and a stop loss leg. If one of those orders is filled, then the other order is 
cancelled. The main order cannot be an OCO, but bracket orders can be legs of an OCO.  

For example, you place a buy bracket order for the E-Mini S&P 500 at 1450.00. You confirm 
that you want to make an 8-tick profit and suffer no more than a 5-tick loss. Once the buy 
order is filled or partially filled, a limit offer to sell at 1452.00 and a stop loss order at 1448.75 
are placed. If one of those orders is filled, then the other order is automatically cancelled. 

Bracket orders are active only when you are logged on to trade. When you log off, you receive 
a confirmation message (based on your preferences) alerting you that you have active bracket 
orders and giving you a chance to cancel those orders. If you do not cancel the orders, then the 
main order is treated as a regular order and the profit and loss legs are cancelled. 

Must be enabled for symbol and account. 
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To place a bracket order 

1. Click the Special Orders button drop down arrow and select BRKT Bracket Mode, 
like this:  

 
Notice that order buttons and watermarks have brackets around them: 

 
 

2. Place your order. A confirmation window opens. 
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3. If you are trading in units, change Lots to Units, if necessary. It is only necessary if 
you are enabled to trade in units, and you have not selected the U button. 

 
 

4. Select ticks or currency for the target order’s profit measurement with corresponding 
values.  

5. Select LMT, ICBG, or TLMT for the target order’s type. 

6. Select the stop type for the Stop Loss. In our example, once the buy order is filled, 
two stop orders are triggered, one at an 8-tick profit (target order) and one at a 5-
tick loss (stop loss order). 

7. Click the Place Bracket button. The order looks like this in the Orders and Reports 
window: 
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To modify and cancel bracket orders 

Modify and cancel bracket orders as you would for any orders on the DOMTrader or Order 
Ticket.  

If you modify the main order price or quantity, then the profit and loss orders are modified 
accordingly. Main legs that are rejected, cancelled, or expire result in the same action on the 
profit and loss legs. 

If you cancel the target profit order, then the stop order is cancelled and vice versa.  

The profit and loss legs of the order are displayed on the Parked window until the main leg is 
filled or partially filled. If the main leg is partially filled, then the profit and loss legs are placed 
with the quantity of the partial fill. The open quantity becomes a new OPO with a new OCO 
(profit and loss) leg. 

Once a working is filled or partially filled, then two orders are triggered on the other side of the 
market, one is stop order and one is a limit order.  

The limit order indicates the profit you want to make and the stop order indicates the loss you 
are willing to take. Once on those orders is filled, the other is cancelled. 
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Entering Iceberg Orders 
An iceberg order is a limit day or GTC order that has both a total quantity and a display 
quantity that is shown publicly on the order book. Only some exchanges support these orders. 

In order to trade iceberg orders, you must be enabled for symbol and account. 

To place iceberg orders 

1. Select ICBG from the duration drop down menu. The order type icon changes: 

 
2. Place your order. This confirmation opens: 

 
 

3. If you are trading in units, change Lots to Units, if necessary. It is only necessary if 
you are enabled to trade in units, and you have not selected the U button. 

 
 

4. Select the quantity that you want displayed. 

5. Click Yes. You see the total quantity, but only the visible quantity is reflected on the 
book. In these images, the total quantity is 1000, and the visible quantity is 100. 
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Entering DOM-Triggered Stop (DTS) Orders 
A DTS order is any type of stop order that behaves like a stop order, but is not triggered until 
the bid/ask quantity falls below the order’s trigger quantity (DOM threshold). All DTS orders are 
supported on all exchanges and are fully synthetic. 

Must be enabled for symbol and account. 

To place DTS orders 

1. Select a DTS order type from the stop management drop down menu.  

2. Press and hold the CTRL key. The order type icon changes: 

 
3. Place your order. This confirmation opens: 

 
 

4. Select the DOM size threshold. 

5. Click Yes.  
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Entering Trailing Limit Orders 
A trailing limit order tracks the market automatically adjusting its price level position in the 
exchange’s order book. 

For a buy order, as the best bid/offer/trade (depending on the smart order type settings) 
moves up, your order moves up with it based on the trailing offset. When the best 
bid/trade/offer trade moves down, your order holds. When the best bid/offer/trade matches 
your order price, the order executes. 

For a sell order, as the best bid/offer/trade moves down, your order moves down with it.  

For example, suppose a market bid is at 1433.00. You place a trailing limit bid at 1432.00, a 
trailing offset of 100. If the market bid moves up to 1434.50, then your order moves to 
1433.50, always keeping a trailing offset of 100 when the bid is moving up. As the bid comes 
down, your order stays put. So, if the bid comes down to 1434.00, your order stays at 1433.50. 
If the bid comes down to 1433.50, your order is executed.  

The goal is that the bid is at the front of the order queue automatically due to the speed of the 
gateway managing the order. 

Must be enabled for symbol and account. 

To place trailing limit orders 

1. Select Trailing Limit from the trailing management drop down menu.  

2. The order type icon changes: 

 
3. Place your order. This confirmation opens (depending on the notifications 

preferences): 

 
Notice the trail offset is 150 because the order is at 150 below market. 

4. Click Yes. 
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Entering Batch Orders 
The Batch Entry function allows you to create a text file on your computer containing one or 
more orders. When you upload the file, each order is verified and entered into our system as a 
parked order. You can upload a maximum of 1000 orders per submission. If your file contains 
more than 1000 lines, the file is rejected. 

You can create the order file using a text editor or any software (word processor, spreadsheet, 
etc.) that save in plain text format.  

Batch file formatting requirements 

Each order must appear on a separate line in the file. 

• A line consists of the following fields, which are separated by a comma: 

Account, buy/sell, quantity, contract [,call/put, strike, new/offset], orderttype [, 
price1] [, price 2] [,duration] [,gtd date] 

• Fields enclosed in square brackets are optional, except that for options orders, the 
Call/Put, Strike Price, and New/Offset fields are required. 

• Price 1 represents the Stop price for STP or STPLMT orders, Limit Price for LMT orders. 

• Price 2 represents the Limit price for STPLMT orders. 

• If not specified, duration defaults to Day. Other valid duration values are: GTC and 
GTD. 

• GTD orders may be specified in either mm/dd/yyyy format or in dd MON yyyy 
format. 

• Fields are not case-sensitive (for example, mkt is the same as MKT) 

Batch Order Fields 
• The Buy/Sell value can be B, Buy, S, or Sell.  

• Contract is the contract code and month/year (for example, USZ1) 

• Call/Put, Strike, New/Offset are required for options orders. 

• Call/Put is the Call/Put indicator (c for a call option, p for a Put option). 

• Strike is the Strike Price for the option. 

• New/Offset is the new/offset value (n for New, o for offset)) 

• OrderType is MKT, LMT, STP, or STPLMT. 

• Price 1 and Price 2 are not present for all order types. 

• Price 1 is the Stop Price for STP and STPLmt orders, or the Limit Price for LMT orders. 

• Price 2 is the Limit Price for STPLMT orders. 

• Price 1 and Price2 must be in the correct price format for the given contract. Price 
formats vary by contract. In any order entry window, the price format is described in the 
quote window below the close, bid/ask, and last prices. For example, C (CBT Corn) is 
shown with the last digit as quarters expressed in eighths (i.e. 0, 2, 4, 6).  
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To create a batch order file 

For format instructions, click Orders on the menu bar, then Batch Order Entry. 

1. Enter the orders into the file, separating fields with commas. 

2. Save the file as Text Files (*.txt). 

To upload a batch file of orders 

 
 

1. Click Orders on the menu bar, then Batch Order Entry. 

2. Enter the path and name of the file or click the Browse button to select the file 
using a dialog box. 

3. If you would like your correct orders displayed, click the Show correct orders 
check box. 

4. Click Submit. 

5. If there are errors in your file, they are listed on the window. Click Cancel, and try 
again after correcting your .txt file. 

6. If your orders are correct, click the Commit button. Your orders are processed and 
are displayed as appropriate on CQG Trader. 
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Managing Orders with DOMTrader 
and Order Ticket 
You can modify order quantity and price, cancel working orders, and liquidate positions directly 
on the DOMTrader and Order Ticket. 

Identifying Order Type Icons 
The DOMTrader uses icons to help you keep track of orders, including: 

 

 
DOM-Triggered Stop 

 
DOM-Triggered Stop Limit 

 
DOM-Triggered Trailing Stop 

 
DOM-Triggered Trailing Stop Limit 

 
Iceberg 

 
Limit 

 

Stop 

 
Stop Limit 

 
Trailing Limit 

 
Trailing Stop 

 
Trailing Stop Limit 
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Viewing Order Status 
Working orders are displayed on the DOMTrader, like this: 

 
 

Hover your mouse over the blue information icon to see order details: 

 
 

Icon Type Description 

 Stacked Stacked orders are multiple working orders (possibly of 
different types) placed on the same side of the market 
for the same price. Double-click the stacked order icon 
to see the details for individual orders. You can also 
press [+] on your numeric keyboard. Pressing [-] 
closes the details. 
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Filled An order changes its status to filled after the server 

receives notification from the exchange that the order 
has been filled. A filled order is visually represented by 
the quantity and a checkmark. 

 
Partially 
Filled 

A partially filled order is a working order with only 
some of the requested quantity filled. This is visually 
represented by black quantity text for the working 
orders and gray text in parenthesis for the filled 
quantity. 
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Fill Report 
When an order is filled, the Fill Report window opens.  

This window provides order details: fill time, symbol, quantity, price, order number, order ID, 
account, and user by default. 

Note that BoughtU and SoldU columns apply to units trading. 

  
 

If you do not want to see this window for future fills, clear the Show on every fill check box 
on the Fill Report window or change Notification preferences. 

You can customize the columns included in Order Display Column preferences. 
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Modifying Working Orders 
You can change the quantity and price of an order in the same way using both the DOMTrader 
and the DOM area on the Order Ticket. 

To change the quantity  

1. Click the order in the Buy or Sell column. 

2. Type a new quantity value or click a quantity button. 

3. ENTER. 

To change the price 

1. Click the order in the Buy or Sell column.  

2. Drag and drop it at a new price.  

3. If prompted to confirm, click OK to apply the change. 
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Canceling Working Orders 
You can cancel orders in the same ways on both the DOMTrader and Order Ticket. 

To cancel an order using drag and drop 

1. Select the working order cell. 

2. Drag the order cell off the window. The order is displayed like this: 

 
 

3. Drop the order.  

To cancel an order using right-click 

Right-click the working order or stack of working orders to delete them. 

To cancel an order using the keyboard 

1. Click the working order.  

2. Press the delete key. 

To cancel an order or all orders using the cancel buttons 

The cancel buttons are at the bottom of the trading window. 

• Click X Buys to cancel all buy orders for current symbol for this account. 

• Click X Sells to cancel all sell orders for current symbol for this account. 

• Click X All to cancel all orders for current symbol for this account. 

• Click X Global to cancel all orders for all accounts 

Go to Setup > Preferences > Display Configuration and select the Enable liquidate and 
reverse buttons check box to view the cancel buttons. 
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To liquidate multiple positions 

Click X All/Liq All to cancel all orders and liquidate all positions for the current account. 

Go to Setup > Preferences > Display Configuration and select the Enable liquidate and 
reverse buttons check box to view this button. 
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Orders and Reports 
The Orders and Reports pane allows you to cancel, replace, and modify orders as well as view 
comprehensive order and position data. 

There are three components to the Orders and Reports pane: the Working Orders window at 
the top and the Orders and Reports windows at the bottom. Use the tabs to move between the 
Orders and Reports windows. 

Hiding the Orders and Reports Pane 
If you would like to display only the trading window and the quote board, you can hide the 
Orders and Reports pane. 

1. Click View. 

2. Click View Orders & Reports to clear the flag. 
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Orders and Reports Components 
The top of the window, the working orders pane, stays the same. The bottom of the window 
displays either order information (filled, parked, cancelled, and exceptions) or reports 
information (open positions, purchases and sales, and account summary). 

 
 

You choose whether to view information for all symbols or for a particular symbol (based on the 
symbol in focus on your trading application): 

 
 

Select the account or all accounts using the Account Selector. 
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Working orders pane 

This pane displays information for all open orders. 

Select the All Symbols button to see details for orders for all symbols or select a symbol 
button to see details for orders that a particular symbol.  

 
 

To cancel an order 

To replace an order 

To create an OCO 

To combine orders into an OCO 

Orders pane: filled orders 

This window displays information for orders that have been filled. 
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Orders pane: parked orders 

This window displays all orders that have been successfully committed, and have not been 
activated for execution. 

 
 

To cancel multiple orders 

To activate a parked order 

Orders pane: cancelled orders 

This window displays information for orders that have been cancelled. 

 

Orders pane: exceptions 

This window lists orders that were rejected by the FCM, the order execution system, or the 
Exchange. 
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Reports pane: open positions 

This window displays the Open Trade Equity, Unrealized Profit/Loss (UPL), and Market Value of 
Options (MVO) for your open positions. 

 

Reports pane: purchases & sales 

This window displays purchases and sales and a transaction log that tracks cash adjustments 
for the account. 
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Reports pane: account summary 

This window displays balances of account-related categories.  

 
Please note that if you have all accounts selected, then accounts are listed vertically, and the 
balances are listed horizontally. To show all accounts, right-click the Accounts pane title bar, 
and then select All Accounts: 

 
Margin Excess, Total Margins Value, and Total Purchasing Power rows are displayed if they are 
enabled in Notification preferences.  

Depending on those preferences, these values can be updated automatically or manually (by 
clicking the Account Summary tab). Automatic updates occur only if the Account Summary 
window is active. The values are updated when you switch to the Account window from another 
window; when a fill, fill busted, or fill cancelled transaction occurs; when a day statement 
environment change occurs; when a current balance environment change occurs; and when the 
quantity of working orders changes. 

Margin excess is the sum of collateral balance, OTE, and MVO minus total margin value. The 
value is displayed as N/A if OTE or MVO cannot be calculated. It is displayed in red if it is a 
negative value.  

If the margin excess threshold is met, the row is highlighted in yellow. If you have more than 
one account displayed, then the header is highlighted. Hover the mouse over the margin excess 
field to open a tooltip. 
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Working with Columns 
You can customize the columns that are displayed for the orders windows (working, filled, 
parked, cancelled, and exceptions). 

Adding, removing, and moving columns 

1. Choose Setup > Preferences > Display Configuration. 

2. In the Order Display Columns box, select an option from the drop down list.  

3. You can elect to apply your selections to a specific Order tab or to All Order Tabs.  

4. Select the columns you want to display, or clear the check boxes of columns you do 
not want to see. 

If you are selecting columns for All Order Tabs, any column that was selected in one 
or more of the Orders tabs, but not in all of them, displays a gray check box. You 
can still select a column with a gray check box if you want to, and this setting affects 
all order tabs. This new setting overrides any settings you made on individual tabs.  

5. Select the column name and click the Clear button or click the check box to clear it. 

6. If the columns are not in the order you want to see them, use the Move to Top, 
Move Up, and Move Down keys to move the selected column up or down in the 
list. 

7. Click OK. 

Changing the column width 

Click and drag the border between the column you want to change and either column next to it 
to resize a column. 

The Orders tab is divided into two sections with a splitter between them, so the Working Orders 
are always visible. You can drag the splitter to make the Working Orders list taller, or to expand 
the section below it that contains Filled, Parked, Canceled and Exception tabs. Each of these 
tabs display the same columns: Buy/Sell, Quantity (Qty), Symbol, Order Price, Type, Limit 
Price, Limit, Place Time, Order ID, Order #, Unfilled, Status, User, Sys ID, FCM Account, Filled, 
Fill Price, and Duration. 

When the Orders tab is visible, the notifications are enabled for the non-working orders. When 
the Reports tab is selected, the notifications are enabled for the report. Working Orders always 
has notifications enabled. 

To sort by a column 

1. Click a column heading. The sort indicator triangle reflects the current sort order. 

2. To change the order, click the column heading again. The sort indicator triangle 
switches to the opposite direction, and the items in the list are re-sorted. 

You cannot sort by all columns. 
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Exporting data 
The data in the Orders and Reports pane can be exported to another application (for 
example, to Microsoft Excel) using standard Windows cut and paste functionality. 
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Working with Units 
If you are trading with units, then QtyU, UnfilledU and FilledU columns are added to the 
orders pane:  

 
 

These columns display the size of the order in units according to the specified conversion rate. 
You can remove these columns in Order Display Column preferences. 

On the working orders window, you can edit the order size in column, QtyU.  

Information about orders includes units: 

 
 

Two columns, LongU and ShortU, are added to the Open Positions and Purchases & Sales 
windows. 
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Managing Orders and Positions 
In addition to using the trading applications to manage orders, you can also use the Orders and 
Reports window to modify and cancel orders. 
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Modifying and Canceling Orders 
The Orders and Reports window provides all of the functionality you need to fully manage your 
orders and positions. On the Working Orders window, you can cancel an order, change an order 
to a market order, create an OCO from an existing order, change the order size, and change 
the order price. 

 

 
 

Note:  A stop limit order can only be replaced with another stop limit order.  

To cancel an order  

1. Click the Working Orders tab to display open orders. 

2. Click the CXL button to cancel a working order. 

To activate a parked order 

1. Click the Parked tab to display parked orders. 

2. Click the ACT button. 

You can also Activate All, Activate All Buys, and Activate All Sells. 

 
 



Fore
xxin

/Cas
ey

  Page 119 

CQG Trader User Guide 

To cancel multiple parked orders 

1. Click the Parked tab to display parked orders. 

2. Click the Cancel All button. 

To replace an order  

1. Click the Working Orders tab to display open orders. 

2. Select the order to be replaced. 

3. Click the order. The selected order is underlined.  

4. Select the element to be changed. 

5. Make the desired changes. These changes appear in red and the RPL button 
becomes active.  

6. Click the RPL button. A confirmation appears if you have selected the Confirm 
orders before placing checkbox in the Trading Preferences dialog. 

7. Click OK.  

To combine existing orders into a single OCO 

1. Click the Working Orders tab to display open orders. 

2. Click the OCO button for the first order you wish to combine. The button becomes 
orange. 

3. Click the OCO button for the next order you wish to combine. Repeat this step for 
each order you wish to be part of the OCO. 

4. When you have finished selecting orders, click the OCO button for the first order that 
you added. Your OCO order is complete. 

Upon execution of one of the orders, the other order(s) are cancelled automatically. 

To create an OCO if you have only one open order 

1. On the Working Orders window, select the order to be modified. 

2. Click the OCO button for that order. The button becomes orange, and the icon on 
the left changes from  to . 

3. Place an order. You receive a confirmation message for that order. Repeat this step 
for each order you wish to be part of the OCO. 

4. After all orders have been placed, click the OCO button for the first existing order. 
Your OCO order is complete. 

Upon execution of one of the orders, the other order is cancelled automatically. 
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To change an existing stop or limit order to market 

1. On the Working Orders window, select the order to be changed. 

2. Click the MKT button. The system cancels the current order and places a new 
market order. 

Note: When market orders are not allowed for a commodity, the MKT button is not displayed. 

To change the size of an order 

1. Click the size field of the order you want to change. You’ll notice a flashing cursor 
when you have successfully selected the field. 

2. Change the size value by typing another number. 

3. Click the RPL button. A confirmation window opens. 

4. Click OK. 

To modify the price of an order 

1. Click the price field of the order you want to change. You’ll notice a flashing cursor 
when you have successfully selected the field. 

2. Change the price by typing another price or part of a price. 

3. Click the RPL button. A confirmation window opens. 

4. Click OK. 
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Managing Positions 
You can view, reverse, and liquidate positions on the Reports pane of the Orders and Reports 
window.  

To liquidate open positions 

1. Click the Reports tab to display open positions. 

2. Click the X button. 

 
 

3. On the confirmation window, click Liquidate. 
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To reverse open positions 

1. Click the Reports tab to display open positions. 

2. Click the R button. 

 
 

3. On the confirmation window, click Reverse. 

To view additional position details 

Click the + button to see last price and all of the orders associated with that open position. 

Click the – button to hide the information. 
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Viewing Quote Data 

 
 

The Quote Board pages (identified by tabs) display the open (O), high (H), low (L), last (L), net 
change (∆), and total traded volume (based on quote display preferences) for the current 
trading session.  

(For our purposes, we will refer to each tab or page as a quote board.) 

Net change = yesterday’s settlement – yesterday’s settlement. If yesterday’s settlement is 
unavailable, then yesterday’s close is used. If market data is unavailable, then net change is 
empty.  

The green arrow indicates that the last price traded was higher than the previous price. The red 
arrow indicates that the last price traded was lower than the previous price. If there was no 
change, no arrow is displayed. Green text indicates positive net change, while red text indicates 
negative net change. Black text indicates a net change of zero or unavailable data.  

  
Black text can also indicate that the instrument is not enabled for real-time data. 
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If trading has ended, a checkmark is displayed next to the Settlement Price. 

 
Red and green underlines indicate new low and new high, respectively. In some instances, a 
price is underlined in both red and a green. This is a rare, but it happens when there is no 
instrument state available to allow the application to determine the open, high, and low so far 
in the day, and a single tick arrives. Then that tick is both the new high and the new low, so 
you see the same price underlined in red and green. 

 
 

Double-click a quote board cell to use that symbol on the trading application. 
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To enter a symbol in the Quote Board 

1. Click a cell to select it. The selected cell is outlined in red. 

2. Enter the symbol. 

If you are authorized for that symbol, and if the symbol is currently trading, the 
information for that symbol is displayed. 

If you are not authorized for a symbol you enter, the background color of the symbol 
turns red and a message appears, telling you that you are not enabled to view that 
symbol. 

Double click a cell in the Quote Board to change this cell’s symbol to match the 
symbol that is displayed on the active tab in the DOMTrader Pane. 

To rename a Quote Board  

1. Either double-click the current name on the tab or right-click the tab and click 
Rename Tab. The current name is highlighted in dark gray. 

2. Type the new name of the window. 

3. ENTER. The name is saved only if you ENTER after typing it, so if you want to cancel 
the change, click anywhere else on the window to exit the edit mode. 

 The maximum length of the name is 150 characters. 
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To add a Quote Board 

Click the + button on the next available tab. 

 
 

When the number of tabs exceeds the space on the screen, the right-most tab displays a down 
arrow. Click that arrow to open the menu to add a new tab. You can also use this menu to 
quickly jump to another quote board. 

 

 
 

You can add up to fifty quote boards. 
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To remove a Quote Board 

1. Right-click the tab for the quote board you want to close. 

2. Click Close Tab. If the page contains quote data, you are prompted to confirm the 
action. 

 

To copy a Quote Board 

1. Right-click the tab for the quote board you want to copy. 

2. Click Replicate Tab. The window is added to the far right of the quote board area. 
The window contains all of the quote data from the original quote board. 

To move a quote board 

Click the tab of the quote board you want to move, and drag it to its new location. 
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News 
The News window includes a Story List on the left side of the window, a Story Viewer on the 
right side of the window, and a Story Timeline on the bottom of the window. The Sources 
and Show filters are at the top of the window with a Search field. Above the Story Viewer are 
the Print, E-Mail, and Font buttons. 

 
 

Click the arrow between the story list and story viewer to hide and show the viewer. Click the 
arrow between the story list and story timeline to hide and show the timeline. 

To open news, click News on the menu bar, and then click News. 
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The Story List 
The story list displays the Dow Jones, Market News, Thomson Financial, Hightower Report, 
Interfax News, and N2K (Need to Know) News in real-time. The three most recent stories are 
listed at the top of the story list, even as you scroll down to previous stories. You can change 
this setting. 

The font size of the headlines is largest for the most recent story and smallest for the least 
recent stories. 

If you have filtered the list, then only those stories that meet your filter criteria are displayed. 
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The Story Viewer 
The story viewer displays the story that is selected on the story list. It also has print, e-mail, 
and font buttons.  

Three font sizes are available. Click this button  to increase and decrease the font size. 

E-mail hyperlinks included in news stories are active. Click those links to send e-mail to the 
contact. 

Double-click the keyword to filter the news stories. For example, if you double-click CURRENCY, 
then only stories with that keyword are displayed in the story list. 

If corrections are made to stories and headlines, the timestamp on the story and the order of 
stories on the News window remain the same. 
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The Story Timeline 
Each bar in the story timeline represents five minutes. The volume of stories is represented by 
the height of the bars. The story timeline includes a scroll tool as well as a GoTo button and 
arrow button for moving between times. 
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Setting News Preferences 

 
 

• Choose one of four color themes. 

• Choose whether headlines should be displayed in different size fonts or all the same font 
size.  

• Select the font size to use: Small, Medium, or Large. 

• Choose whether to display the filter and search bar, the story pane, and the timeline.  

• Choose whether you want the default keywords displayed in the filter. If so, the Show 
menu looks like this: 

 
• Choose whether you want search words to be highlighted in the results. 

 

Click Apply to save your changes and keep the preferences window open. 

Click OK to save your changes and close the preferences window. 
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Issues with foreign language characters 

If foreign language characters are not being displayed properly, you may need to change your 
computer settings. 

Go to the Control Panel and select Regional and Language Options. On the Advanced tab 
in the Language for non-Unicode programs section, change the language to match the 
foreign language displayed in the news stories. 

Reading News Stories 
To read a story: 
Click the story headline in the story list. You can then read the story in the story viewer. 

To open a story in a new window: 
Double-click the story headline in the story list. 
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Finding Previous Headlines  
Scrolling the Story List 

1. Click a headline in the story list.  

2. Use the up and down arrows on your keyboard to scroll up and down the list to move 
to other stories.  

3. ENTER to open the story in the story viewer. 

When you scroll beyond the timeframe of the stories displayed, the story list splits into two 
parts. The top part of the list always contains the three most recent stories and updates in real-
time. The bottom part of the list contains the stories for the time you scrolled to. 

Scrolling the Timeline 
Click the timeline at the time for which you wish to see headlines. Those headlines are 
displayed in the story list. 

The timeline also has a scroll tool that looks like this: . Drag that tool to the time for 
which you wish to see headlines. Those headlines are displayed in the story list.  

To return to the current time, click the green arrow on the right of the timeline.  

Using GoTo 

 
1. Click the GoTo arrow in the lower left corner of the News window. 

2. Enter the time for which you wish to see headlines. 

3. ENTER. The headlines for that time are displayed in the story list. 
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Filtering News Stories 
CQG Trader has provided over two dozen pre-set filters for you. These filters include: Currency, 
Energy, Food, Financial, Grain, Metals, Shipping, and Technical. Filters are based on the 
keywords provided in the news stories. 

 
 

You can also enter your own keywords for headlines in the Show field. Your own words are 
saved at the top of the drop down menu. You can remove them by clicking the X. 

 
 

The Sources drop down allows you to filter stories by source. 
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To filter by keyword 

1. Click the dropdown arrow for the Show filter. 

2. Click the desired filter. Headlines for stories with that keyword are displayed in the 
story list. 

Keywords are located at the end of stories on the story viewer. You can also double-click these 
keywords to filter news stories.  

To filter by custom keywords 

1. Type a keyword or keywords in the Show drop down field. You can use AND and OR 
to further define your search. 

2. Click Enter on your keyboard. Headlines for stories with that keyword are displayed 
in the story list. 

To filter by news source 

1. Click the dropdown arrow for the Sources filter. Sources that are checked are 
included in the headlines. 

2. Click the source to remove the check, and the source is removed. The All Sources 
check has to be removed before you can remove individual sources. 

3. Click anywhere outside of the Sources menu to close it. 
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Searching for News Stories  

 
Enter your search criteria and then click Search. The News Search window opens. 

How to format search criteria 

You can enter a keyword or text. If you enter punctuation, that punctuation is considered part 
of the search. 

You can use these operators to further define your search: 

• AND: When you add “AND” between values, the system searches for news stores that 
contain all of the search values.  

If you enter several values without an AND, then the AND is assumed. If the values 
meet the criteria of a keyword, then they are treated as such. “Financial Currency” is 
an example. 

• OR: When you add “OR” between values, the system searches for news stores that 
contain any of the values.  

Including OR in your search indicates that you want to search for everything before 
the OR and everything after the OR. For example, if you enter: Japanese or 
American car and production, then any story that includes “Japanese” is returned 
and any story that includes “American car and production” is returned. 

• EXC: When you add “EXC” before a value, the system searches for stories that do not 
include the value following the EXC.  

This is the only operator that can begin your search criteria. If you begin the search 
with AND or OR, they are ignored. 

• - : Adding a hyphen in front of a value works the same way as EXC.  

If you enter a hyphen followed directly by a value without a space in between, it is 
treated as EXC. 

• “ ”: When you place single or double quotes around a value, the system searches for 
stories that include that exact phrase. 
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To add advanced search options 

 
Click the More search options check box on the News Search Results window to expand the 
available search options: 

 

 
 

The search criteria fields in this view help you further define your search without your having to 
enter operators, such as AND and OR. If you enter operators in these fields, the system 
searches for those words. It is likely that you will receive an error message asking you to 
remove common words, as they occur too frequently for the system to return meaningful 
results. 

You also have the option of searching in a particular category and during a specific period of 
time: the last 24 hours, the last week, this month, last month, and all available. A maximum of 
200 results are returned. 

Dow Jones Search Codes can be added also. For more information about Dow Jones Search 
Codes, go to: http://www.djnewswires.com. Please note that search codes can be used in this 
advanced view only. 
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Viewing Search Results 
The stories that match your search criteria are listed on the right side of the window. A 
maximum of 200 results are displayed. 

 
 

Double-click the headline to read the story. It opens in another window. 

To group and sort search results 

By default, stories are grouped by news sources. Click Category to sort by the first keyword 
listed in the story. Click No Grouping to list all of the stories based on the sort parameter you 
select. 

Once you have selected the grouping, you select how you want the stories in the group to be 
sorted. Click Name if you want an alphabetical list. Click Date/Time if you want a 
chronological list. Click Source if you want a source list. 
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To change the search 

 
Click the X button in the search field to begin a new search. 

 

Printing and E-mailing News Stories 
The print and e-mail buttons are at the top of the story viewer and on each story window you 
open. 

To print a story, click this button: . 

To e-mail a story, click this button: . 
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Messages 
You may receive error, warning, or informational messages occasionally from your FCM or from 
a system administrator. 

Error messages are displayed with a white x inside a red circle:  

Warning messages are displayed with a black exclamation point (!) inside a yellow triangle:  

Information messages are marked with a blue exclamation point inside a white quote bubble: 
 

Error and warning messages are displayed as soon as they are received. Informational 
messages are indicated by a blinking taskbar button. Clicking that button open the Messages 
window.  

The top pane of the window lists messages received. The bottom pane displays the complete 
text of the message selected in the list. The most recently received message appears in the 
index at the top of the list.  

Reading messages 
You can read your messages any time you are logged in to CQG Trader. 

1. Click View > View Messages. The Messages window is displayed. 

2. Click a message in the list to display it in the bottom pane.  

You can view messages that were not expired at the time you logged on and which have not 
been deleted during the current session. Messages that have not been read yet appear in the 
index in bold text.  

Deleting messages 
The message viewing screen (not the message list) displays a Delete button you can use to 
delete the current message. You can only delete one message at a time. 

1. Display the message in the message viewing screen. 

2. Click the Delete button. The message view screen closes and the message is 
removed from the Message list. Once deleted, the message are no longer accessible. 
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Exchange Connections 
Exchanges may have different trade routing practices. 
LIFFE/eCBOT 
Pre-Open Market Orders 

If you place a market order in pre-open, then the market order is converted to a market on 
open (MOO) order. Spread MOO orders are rejected. When the market opens, MOO orders are 
filled at the open price. The exchange converts them to limit day orders with the price equal to 
open price. The messenger cancels the market order and places a limit order. 

Stop Orders 

How orders are submitted to the exchange: 

MKT STOP orders are submitted as market stop orders with LIFFE order price equal to the 
trigger price. 

LMT DAY STOP orders are submitted as stop orders with the order price equal to either the limit 
or trigger price. Orders with different limit and trigger prices are rejected. 

GTC STOP orders are submitted as GTC stop orders with the order price equal to the trigger 
price. GTC stop limit orders with different limit and trigger prices are rejected. 

All stop limit orders are synthetic. 

Native stop orders work like this: 

 

You enter… and the exchange converts it to... 

STOP DAY a market order when market reaches the stop price and that is 
automatically cancelled at the end of the session. 

STOP GTC/GTD a limit order when market reaches the stop price. The limit 
price is the same as the original stop price. 
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Getting Help 
The Help menu at the top of the CQG Trader window provides access to online help, a list of 
tradable symbols, a quick reference for keystrokes, and FCM contact information. You can also 
right-click the Quote Board title bar to access these options. 

Opening Online Help 
Select Help > Online Help. 

This online help system contains the complete text of the printed documentation for CQG 
Trader, enhanced with features like full text search and related topics links to make it easier for 
you to find what you are looking for. The online help is divided into sections, which are 
displayed as books in the Contents tab to the left:  

 
Click the book to expand and collapse a section. Click a title to display the topic. 

The Back button displays the previous topic in help. This may not be the last topic you viewed. 
To return to the topic you last viewed, use the Back arrow on your browser toolbar. The 
Forward button displays the next topic in help.  
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To search help 

 
 

Type the word or phrase to search for, and then press Enter or click Go. The Search pane 
displays a list of all the topics in your Help system that contain the word or phrase you entered. 
If you search for multiple words, the search finds Help topics that contain all the words you 
entered. When you click one of the items found by the search, each occurrence of the term or 
terms you searched for appears highlighted in the topic. 

To print help topics 

 
Click the Print button to print the current help topic.  

To save favorite topics 

 
Click the Favorites button to save the currently displayed help topic to your help favorites list. 
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Opening the Keyboard Shortcut List 
Select Help > Key Actions to open a quick reference guide for keystroke entry on the 
DOMTrader. 

Click the Print button to print the list. 

In order to trade using your keyboard, go to Setup > Preferences > Order Placement and 
select Enable Keyboard Trading. 

Opening the Tradable Symbols List 
Select Help > Symbols List to open the latest list of tradable symbols. 

Account permissions and routing options determine whether your account is able to trade these 
symbols. Check with your FCM to find out what exchanges your account can access and what 
your account permissions are. 

Opening the About window 
Choose Help > About.  

This window contains FCM contact information, your user number, and the version number and 
copyright information for CQG Trader. 
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